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Disclaimer: 
The author and publisher have used their best efforts in preparing this Book.  The author and 
publisher make no representation or warranties with respect to the accuracy, applicability, 
fitness, or completeness of the contents of this Book. 
The information contained in this book is strictly for information purposes.  Therefore, if you 
wish to apply ideas contained in this book, you are taking full responsibility for your actions.  
Whilst we hope you find the contents of this book interesting and informative, the contents are 
for general information purposes only and do not constitute advice.  We believe the contents 
to be true and accurate as at the date of writing but can give no assurances or warranty 
regarding the accuracy, currency or applicability of any of the contents in relation to specific 
situations and particular circumstances. 
This Book is not intended to be a source for advice, and thus the reader should not rely on 
any information provided in this Book as such.  Readers should always seek the advice of an 
appropriately qualified person in the reader's home jurisdiction.  The author and publisher of 
this Book assume no responsibility for information contained in this Book and disclaim all 
liability in respect of such information.  In addition, none of the content of this Book will form 
any part of any contract or constitute an offer of any kind. 
Any links to third party websites are provided solely for the purpose of your convenience.  
Links made to web sites are made at your own risk and the author and publisher accept no 
liability for any linked sites.  When you access a website please understand that it is 
independent from the author and publisher and the author and publisher have no control over 
the content of that website. 
Further, a link contained in this book does not mean that the author or publisher endorses or 
accepts any responsibility for the content or the use of such website.  The author and 
publisher do not give any representation regarding the quality, safety, suitability or reliability of 
any of them or any of the material contained within them.  Users must take their own 
precautions to ensure that what is selected for use is free of such items as viruses, worms, 
Trojan horses and other items of a destructive nature. 
All web sites, products and services are mentioned, without warranty of any kind, either 
express or implied, including, but not limited to, the implied warranties of merchant ability and 
fitness for a particular purpose. 
Some of the links contained within this Book are affiliate links to third party Companies, which 
means the publisher or author may receive a small payment/commission if any purchases are 
made or agreements signed with any of the third parties. 
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Introduction 

Most people, at some time in their lives, have thought of writing a book. But 

with no way of knowing how to have it published, the idea was usually passed 

over and forgotten. 

And the old, frustrating way of trying to become a published author was to first 

write a book and then start sending out letters and sample chapters to as 

many agents and publishers as you possibly could. 

Sadly, out of every 50,000 manuscripts a publisher receives, only 1 or 2 are 

actually published - AND it usually takes 3 to 4 years before your book will go 

to press. 

And then, after all that, it’s STILL your responsibility to market your own book - 

at your own expense - while the publisher saves their marketing efforts for 

their best-selling authors. 

And if that’s not hard enough; if your book sales are considered by the 

publisher to be low - say, less than forty thousand a year - then your book is 

quickly withdrawn and listed as “out-of-print.” 

So don’t waste your time sending your manuscript out to hundreds of 
publishers. 
Instead, publish it yourself. 

Authors have been self publishing their own books successfully for over one 

hundred years. 

Just look at this list of just a few of the well-known authors who all began by 

self publishing their own book -  

• Oscar Wilde 

• Rudyard Kipling 

• George Bernard Shaw 

• Mark Twain 

• Beatrix Potter 

• Deepak Chopra 

• Virginia Woolf 
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• John Grisham 

• Christopher Paolini (Eragon) 

ALL these authors began their careers by self publishing their own book. 

And you can do the same. 

All you need is access to a computer and an internet connection. 

There’s never been a better time to easily publish a book and sell it 

internationally. 

And the really great thing about being a published author is that it never has to 

end.  Not only can you utilize modern publishing methods to keep your book 

‘in print’ for as long as you want, but you can expand your writing talent and 

publish more and more books every year – or every month if you’ve got plenty 

of time to write. 

Holding your first printed book in your hands is one of life’s most thrilling 

feelings, and the more books you write, the more times you can relive that 

feeling with the first copy of every book. 

And when someone asks you what you do for a living and you say “I’m an 

author” that’s also a great feeling. 

HOW DO YOU MAKE MONEY FROM SELF PUBLISHING BOOKS? 
Publishing books isn’t just about writing them, you have to sell them too. 

And if you want to know how easy it is to make money from selling books, 

look at it this way;  

There are nearly 200 countries in the world. 

If you wrote just one book and only sold 10 copies per country per year, and 

made $10 profit per book, you’d earn $20,000 a year. 

And if you published 6 books and sold 10 copies of each book per country per 

year, that would mean you’d be earning a 6-figure income. 

But just how EASY is it to sell so many books every year? 

Let’s look at something else. 

There are over 115,000 libraries across the US. 
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Now what if ONLY HALF of those libraries only ordered just 1 copy of your 

book? 

That would mean you’d sell 57,000 copies! And that’s only the US libraries.  

There are also tens of thousands of libraries in the UK, Australia, New 

Zealand…and the list goes on. 

There is also the possibility of sales to book clubs.  These types of clubs can 

help you sell 20,000 (or more) copies of your book – in one sale! 

Now I’m not guaranteeing that you’ll actually see these high sales, but it’s 

DEFINITELY possible. 

And there are also many other opportunities that will open up once you’re a 

published author. 

People self publish books for many different reasons.  Just look at what YOU 

can do: 

A Unique Gift for the Whole Family 
You can write and publish a personalised book to give as a unique gift to 

friends or family members. 

To Become an Expert in Business 
You can use your self published book as a spring-board to advance your 

career.  Once you’ve written and published a book you are seen as an expert 

and you can use your status as a published author to enhance your business 

or to set yourself up to work as a seminar speaker. 

Start a Book Publishing Company 
Once you know how easy it is to publish your own books, you can do the 

same as I did and start your own book publishing company. 

Start Your Own Online Business 
Once you’ve published your first book, you can set up your own online 

business.  You just write a book, publish it and then set up a web site based 

on the subject of your book and make money selling your book, an ebook 

version of your book, work as an affiliate by getting paid commissions to sell 

other people’s products (related to your book’s subject, of course) and 

accepting paid advertising. 
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For instance, say you written and published a book about weight loss.  You 

could then set up a fitness/weight loss web site and sell your book, other diet 

and nutrition books (or write and publish more books yourself), exercise 

equipment, meal supplements, vitamins, etc... 

And all it takes to get started is to publish just one book, and from there you 

can do almost anything. 

Writing and publishing books is like working once and getting paid for it over 

and over again. 

But if you stay at home as an unpublished writer, then no one even knows that 

you’re there. 

But as soon as you publish your first book, the whole world will know about 

you and you can achieve SO MUCH once you are a published author. 

And self publishing lets you stay completely in control of your work so that you 

can sell as many books as you want, from where ever you want and whenever 

you want. 

But you need to know where to start and how to do it, and Self-Publish 
Worldwide will help you do just that. 

With this book you will learn what you need to do, how to do it and where to 

go to find everything you need to begin publishing your books. 

Most other books about self-publishing will tell you about printing and 

marketing but they leave out the important things like how to actually go about 

having your book distributed internationally without breaking the bank and 

without spending hours and hours packing up dozens of boxes of books in 

your garage and then paying to have them shipped all over the world. 

In Self-Publish Worldwide you’ll learn how to automate the whole process 

with no printing and storing books required. 

And don’t worry about marketing.  You’ll learn how to easily and effortlessly 

market your book online for free.  You’ll discover that you don’t need to be an 

extrovert to market your book successfully and most of your marketing can be 

done from home and without the need to hire a company to write you a press 

release or marketing kit.  And contrary to popular belief, sending out a mass-
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mailing of your marketing material isn’t as profitable and successful as the 

cheap and easy way I’ll show you to market your book online yourself. 

Self-Publish Worldwide is a huge book, a jargon-free easy-to-understand 

manual that tells you EXACTLY what you need to know to begin, so you can 

publish one book or a thousand books.  You can even use all this knowledge 

to start your own publishing company - I know, because that’s what I did. 

Whatever your reasons for wanting to become a self-published author, you’ll 

find all the information you need to get started right here.  And it’s all laid out 

in an easy-to-understand, step-by-step structure so you’ll know what to do, 

how to do it and have links to companies that can help. 

Just follow all the steps in this book and in 2 weeks time you’ll be a published 

author. 

I wish you all the publishing success in the world. 

Ruth Barringham 

http://writeaholics.net

http://selfpublishworldwide.com

http://newonlinecourse.net

http://cheritonhousepublishing.com
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Different Ways to Self-Publish 

The problem with reading anything about self-publishing is that there’s 

conflicting statements on almost any website and it’s all written in so much 

jargon that the more you read the more confused you become.  But I will cut 

through all the technical terms and publishing jargon and help you to 

understand the different opportunities open for you to self-publish your book. 

There are 4 different ways to publish a book: 

• Traditional Publishing 

• Self-Publishing 

• POD Publishing 

• Vanity Publishing 

 

Traditional Publishing 
With traditional publishing there is no cost to the author.  You can pitch your 

book to an agent or directly to a publisher to try and encourage them to 

publish your book for you. 

Currently only about 1 out of every 50,000 books submitted are successful.  

But if your book is accepted for publication it will probably be 18 months to 4 

years before your book is in print and you will still be expected to market and 

promote your book yourself for a royalty payment of around 10% for every 

book sold.  It can be 10% of the net amount, which is what the publisher 

actually sells the book for, or 10% of the price on the cover of the book. 

Vanity Publishing 
This is sometimes called Subsidy Self-Publishing but whatever you choose to 

call it, it means that you, the author, pay a vanity publisher to do all the work 

that a traditional publisher would have done.  You do get paid higher royalties, 

usually from 25% to 40%, but it can still take quite a while before you break 

even, depending on how much you paid to have your book published in the 

first place. 
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POD Publishing 
Print On Demand publishing lets you self-publish your book with minimum 

expense.  POD books are individually printed when an order is placed which 

means no warehousing costs and this dramatically reduces production costs.  

But Print On Demand companies are usually only printers not publishers, 

although they can offer some publishing services.  And so it’s still up to the 

author to market and sell their own work. 

So before you approach a company, your manuscript must be what they call 

“copy ready”.  This means that your manuscript must be formatted correctly, 

all the necessary pages are included (e.g. copyright page, disclaimer page, 

etc) and you have a book cover ready for printing. 

Self-Publishing 
When you publish a book yourself you take on all the work that a traditional 

publisher would have done for you.  This includes having your book printed, 

shipped, distributed and you also have to take care of all your own paperwork. 

Which is best for you? 
As we are dealing here with self-publishing, we’ll only be discussing the latter 

3 ways to publish a book, that is, Vanity, POD and Self-Publishing.  Which of 

these ways you choose will depend on several different factors. 

Firstly your choice will depend on how much of the work you want to do 

yourself.  If you just want to get your book published and then carry on with 

writing the next one, then you may opt for vanity publishing. 

On the other hand if you’re a bit of a control freak and like to be in charge of 

the publishing process, then you may decide to go the whole self-publishing 

route yourself and deal with every company and every aspect of publishing 

personally. 

But before any of this happens, it’s best to have a clearer understanding of the 

publishing process, which will be explained as we go along. 

In the following pages we’ll look at all three ways to self-publish your books. 
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Vanity Publishing 

If you feel daunted by all the steps involved in self-publishing your own book, 

then vanity publishing, or subsidy publishing as some like to call it, can offer 

you an easy alternative. 

There are certainly plenty of authors who are happy to use a vanity publisher 

because it saves them the work involved in: 

• Book registration 

• Cover designing 

• Dealing with printing companies 

• Warehousing 

• distribution 

• Legal deposits 

• Invoicing 

• And more 

It’s easy to use a vanity publisher because you only have to pay them once 

and they’ll take care of the whole book publishing process for you. 

The most well-known of vanity publishers is Lulu.com. 

On their website it’s free to upload your manuscript, choose your book type 

(hardback, paperback, etc), size, cover design, price and everything else 

necessary for producing a finished book.  Then every time someone goes to 

the site and orders a copy of your book, Lulu.com prints and ships it and takes 

a percentage of the selling price. 

Using Lulu.com means you can have your book published and available for 

sale internationally in a matter of minutes.  The downside is that the average 

number of book sales from publishing on Lulu.com is 10. 

But that’s not to say that there’s anything wrong with using Lulu.com.  On the 

contrary, if you want to publish a book and sell it to a small group of people, or 

buy your own copies to give away as gifts or prizes or distribute them to your 

employees, then Lulu.com will be just the kind of self-publishing company that 

you’re looking for. 
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Another way that authors are using Lulu.com is to publish their book as an 

ebook and sell it from their own website or through other ebook websites 

(more on this later) and use Lulu.com to offer an alternative printed version of 

their book. 

Most other vanity publishers will take your manuscript and turn it into a printed 

book for you and either charge a set fee or price their services individually. 

The best known of the vanity publishers are: 

• iUniverse 

• Xlibris 

• AuthorHouse 

• CreateSpace 

 

They are also the most widely used of all the vanity publishers. 

CreateSpace seems to be the top favourite company of self publishers and is 

owned by Amazon.com.  CreateSpace now also works with some of the 

biggest publishing houses in the world by using POD (Print On Demand) to 

make out-of-print titles available ‘in print’ again.  Some of the big companies 

that use CreateSpace include Cambridge University Press, Harper Collins and 

Oxford University Press. 

But they are not cheap and to have a book published with CreateSpace 

(including a book cover and ISBN) will set you back well over $1,000 

iUniverse charges much less than CreateSpace, but there is an even higher 

fee if you want to leave their service and take your book files with you. 

Xilibris charges around $2,000 for their publishing service and supplies a few 

“free” copies of the book to the author.  It takes 4 to 6 months for publication 

of your book. 

AuthorHouse charges around $1,500, takes 6 months to publish a book and 

they claim ownership of your book files which means you cannot use them 

again.  So if you decide to publish your book elsewhere you’d lose your cover, 

ISBN, barcode and manuscript formatting and anything else you paid for. 
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But vanity publishers are great if it is the only way you want to publish your 

book.  Just be careful of all the hidden charges such as extra costs for printing 

images, distribution costs and delivery charges. 

Make sure you read a contract carefully before you sign up with a vanity 

publishing company. 

Also be aware that Xilibris, iUniverse and AuthorHouse are all owned by one 

holding company called Author Solutions. 

To find out much more about these companies, and many more, read a copy 

of The Fine Print of Self Publishing, written by attorney Mark Levine. 

In Australia there is a new vanity publishing company called BookPal.  They 

are based in Brisbane in Queensland and offer publishing packages from 

around $5,000.  Their biggest package includes copy editing of your 

manuscript.  BookPal are also a printing company (formerly called PrintPal) 

and so can do all their own printing in-house. 

Also don’t forget that whichever vanity publisher you choose to publish your 

book with, marketing and advertising are always left to the author.  But this 

isn’t necessarily a tragedy because even if a traditional publisher published 

your book, you’d still be expected to do all the marketing and advertising. 

So you may also want to take advantage of their marketing packages too.  

Most vanity publishers offer marketing packages as an additional extra.  

These packages can range greatly in price but offer things like marketing 

materials, writing a press release and distribution of the press release to 

various media. 

Other Vanity Publishers: 
Ink Tree Ltd 

http://www.inktree.com

Elderberry Press 

http://elderberrypress.com

Greenleaf Book Group 

http://www.greenleafbookgroup.com
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Alternatively there are also many printing companies that will not only print 

your book and give you a free ISBN, barcode, etc, but they also offer a 

publishing service too. 

One such company is The Book Printing Company at 

http://www.bookprinting.org.uk.  They charge a set fee and will give you a 

publishing package which includes: 

• ISBN allocation 

• Registration with book data libraries 

• Registration and upload with POD printers 

• Registration with legal deposit libraries 

• Availability with online and high street book stores in the UK, e.g.  

Amazon.co.uk, W H Smith and Waterstones 

• Royalty management 

• 20 free copies of your book 

 

Just bear in mind that “availability” to book stores usually means they’ll include 

your book in their catalogue only once. 

POD Publishing 

Thanks to the internet and digital printing, POD (Print On Demand) publishing 

is now one of the most economical ways for an author to publish their book. 

Books published using POD are kept electronically on file and are only printed 

when ordered, and shipped anywhere in the world. 

This completely eliminates the need for storing or warehousing thousands of 

books which dramatically reduces the cost of publishing.  Instead, copies of 

your book can be printed only when ordered and shipped anywhere you want. 

POD also means that it’s easier to keep titles “in print”.  Publishers used to 

only keep books in print if they were selling well.  As soon as there was a 

slump in sales publishers would stop doing reprints and once all the stock was 

sold the book was listed as out of print.  For some authors this could mean 

seeing book sales for only a few years, or worse, a few months. 
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But POD means that books can be kept “in print” for years.  In fact traditional 

publishers are making available through POD, titles that they haven’t sold for 

decades, so more and more books are coming back into print. 

But you have to be careful of companies that claim to be POD publishing 

companies but are not. 

These companies advertise themselves as offering POD for self-publishers, 

but when you read further, what they’re offering is small print runs of only 50 

or 100 books.  But any printing company can do short print runs of books.  

And it isn’t really Printing on Demand if no one except the printing company is 

demanding that the books be printed. 

True POD means printing books only when they’ve been ordered by a 

customer or retailer. 

In the UK there is a true POD company called Antony Rowe Ltd at 

http://uk.cpibooks.com.  This company will set up your title in their digital 

library and make it available for sale through Gardeners’ Books who are 

Britain’s largest book wholesaler and run the biggest distribution and ordering 

network in the UK. 

For a small fee your book can also be printed and made available in the USA 

too. 

They send you a proof copy for your approval when they first upload your 

cover and book block, and then, using Gardeners Books, your book can be 

distributed anywhere in the world.  And all they charge is the cost of printing. 

I personally think that the name Antony Rowe Ltd has a classy ring to it. 

Gardeners’ Books in the UK (in association with Antony Rowe) also offer a 

Print on Demand service with a 48 hour turnaround from order to dispatch. 

There is also the Spanish POD company, Publidisa.com.  They offer a true 

POD service to produce POD books and ebooks.  They charge a fee for 

setting up your book and then accept orders and send the book directly to the 

customer.  Publidisa.com is the same company used by Lulu.com. 

But the daddy-of-them-all in POD publishing is Lightning Source Inc in the 

USA. 
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Lightning Source works with both authors and publishers to produce POD 

books and ebooks. 

One of the most impressive facts about Lightning Source is that it’s owned by 

the same company that owns Ingram Book Group.  Ingram’s is the biggest 

book wholesaler in the US and supplies books to over 90% of book stores 

across America in addition to supplying online book stores, libraries and 

schools. 

Once your book is printed by Lightning Source it’s automatically listed with 

Ingram’s.  Ingram’s do actually keep in stock some of Lightning Source’s best 

sellers, but all the others it can get from Lightning Source overnight so all 

Lightning Source books are listed with Ingram as being immediately available. 

Amazon.com draws its stock directly from Ingram’s daily electronic catalogue 

so if you use Lightning Source you’re guaranteed that Amazon.com will list 

your book and it’s usually listed within a few days. 

In fact Lightning Source supplies books to all the Amazon online book stores 

including Amazon in Canada, France, Germany, the UK and Japan. 

A few major booksellers also have the resources to tap into Lightning 

Source’s electronic systems and order directly instead of going through 

Ingram.  These include: 

• Baker & Taylor, who are the second largest U.S. book wholesaler and 

the largest supplier to U.S. schools and libraries. 

• NACSCORP, another major wholesaler, as a service of the National 

Association of College Stores. 

• Amazon.com.  Though Amazon normally orders from Ingram to fill 

immediate customer demand, it orders directly from Lightning Source 

to stock a book. 

• Barnes & Nobel, including BN.com, one of the biggest book store 

chains in the US (their bigger stores stocking over 100,000 titles at a 

time) also order their books directly from Lightning Source. 
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Lightning Source also has a company in the UK called Lightning Source.co.uk 

but it’s actually Lightning Source Inc in disguise.  So whether you go to  

http://www.lightningsource.com

Or 

http://www.lightningsource.co.uk

you’ll be taken to the same Lightning Source website and from there they’ll 

decide whether you should be paid in UK Pounds or US Dollars. 

Books handled by Lightning Source Inc can easily be printed and distributed 

by Lightning Source UK as well - and vice versa. 

Lightning Source also supplies books to the UK’s biggest book wholesalers, 

Gardner’s Books and Bertram’s Books who supply books to one of Britain’s 

largest book store chains, Blackwell’s. 

So when you publish your book using Lightning Source, your book becomes 

immediately available through Ingram’s and Baker & Taylor in the US, and 

Gardener’s and Bertram’s in the UK.  Book stores throughout the world can 

place orders for your book through these wholesalers. 

At Lightning Source they receive orders for your book directly or through one 

of their distribution partners.  They then print the books, pack and ship them, 

send invoices, receive payments and send you a monthly statement.  The 

only thing they deduct is the cost of printing and they send you a monthly 

cheque for the rest. 

Their set-up fees are quite modest too.  At this time of writing, their set-up fee 

to get a book into their digital library cost around $100 (US) for the first book 

and around $65 (US) for every subsequent book.  Or if you plan on publishing 

9 or more books a year they can offer a substantial discount.  They also 

charge a small yearly fee for keeping your book in their digital library. 

If your book cover doesn’t have a bar code, they will also place a free bar 

code sticker on your books. 
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By using Lightning Source to print your book, you don’t need to do a large 

print run of your book, but you will still need quite a few for promotional 

purposes, review copies, gifts, and so forth. 

Lightning Source leave it up to you to choose the cover price of your book, 

trade discount offered and return-ability and they also provide a proof copy for 

your approval (for a small fee). 

Lightning Source works with publishers and authors from all over the world so 

no matter where you live you can work directly with Lightning Source. 

This way, POD companies like Lightning Source Inc and Antony Rowe 

remove the problem of distribution for self-published authors. 

But you still need to get your book interior and your cover to the stage of 

‘printer ready’ so in the next chapter, which explains all the steps in the actual 

self-publishing process, you’ll learn how you can easily achieve this. 
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Self Publishing 

In this chapter we’ll be discussing the whole self-publishing process and the 

steps you need to take. 

At first it may seem a bit confusing.  So I suggest that you read through all the 

information first before going back and deciding what is the best way for you 

to publish your book. 

Once you know what you want to do and know the steps that you need to 

take, you’ll realise how easy everything is, especially with the links that are 

provided throughout this ebook to websites that can help you to find 

everything you need. 

When you self-publish your book it can at first seem to be a lot of hard work, 

but it does put you completely in control of the publishing process and returns 

a much higher profit.  And once you know how to publish a book it becomes 

much easier the next time. 

How much time and effort you need to put into publishing your book will 

depend on the way you tackle each process.  For instance, you could design 

and create your own book cover, or alternatively, you could pay a book cover 

designer to do it for you. 

When it comes to publishing, everything can be done by you or out-sourced to 

others.  This includes setting out the interior of your book, marketing and even 

printing. 

It can take from 2 weeks to 6 months to get a book published, depending on 

which way you decide to do it, so first of all you need a definite date for 

publishing your book so that you have a deadline to work towards.  With your 

first book it might be wise to set a date 3-6 months in advance to be sure that 

you get everything done. 

On the other hand, once you understand the process you need to go through 

to self-publish your own book, you might feel confident enough to be ready to 

upload it to the printers in as little as 2 weeks. 
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The Self Publishing Process, Beginning to End 

To begin with, it’s assumed that you have already written your book 

manuscript and that’s why you’re ready to publish it now.  So we’re going to 

start with the first thing you need to do before you can begin the physical 

process of publishing your book.  And this first step is SO IMPORTANT that it 

can make or break your publishing success.  So you MUST get this absolutely 

right before you move on. 

Writing Your Sales Page 

Believe it or not, writing a great sales page is more important than writing a 

great book.  You can sell a mediocre book with a great sales page, but you 

can’t sell a great book with only a mediocre sales page. 

So this is one thing you definitely MUST get right.  Having a great sales page 

is a big part of a strategic plan to be a successful author which includes -  

• Writing a great book 

• Writing persuasive ad copy for your sales page 

• Designing a web page where you can sell your book (essential) 

• Powerful ongoing marketing. 

Write the Sales Page First 
By writing your sales copy first you can really let your imagination run wild as 

you describe all the benefits of owning a copy of your book.  Even if you’re 

writing fiction you can describe the horror/fear/emotions that your book will 

elicit from the reader. 

It’s usually best to write your sales page before you write even one word 
of your book. 

But if your book is already written, it’s still possible to write powerful sales 

copy for it, and as your book is not published yet, it may not be too late to add 

any great ideas you come up with. 

And as you write your sales copy, you WILL come up with great ideas about 

the benefits of your book.  By the time you’ve finished writing it, your sales 

page will be so irresistible that readers will be itching to grab a copy of your 
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book, and that’s why you should always provide access to an instantly 

downloadable ebook copy as well (but we’ll get into that in more detail later). 

Your Sales Page Design 
The most important part of your sales page is the copy.  It’s not the fancy 

images and graphics that make the sales, it’s the words.  In fact you don’t 

even need anything fancy on your sales page.  If your writing is hypnotic and 

compelling enough then that’s all you need. 

You also need your page to be fast loading so avoiding things such as 

flashing graphics is preferable. 

Another thing to keep in mind is the search engines.  You need to make sure 

your sales page turns up in the top 10 results for anyone searching the topic 

you’ve written your book about, so you need to keep keywords in mind. 

Keywords aren’t as important as good sales copy, so don’t get too hung up on 

it. 

Just do a quick search at http://www.wordtracker.com for the top 100 

searches in your book’s category. 

This will give you some idea of what information people are currently 

searching for the most.  But it is only a CURRENT list, so like I said before, 

don’t get too hung up about keywords, but DO keep them in mind. 

Writing Your Sales Copy 
Every paragraph, sentence and word in your sales copy only has one 

purpose.  To drive customers to an order page for your book.  And although 

you want your writing to sound professional, it also needs to sound personal, 

as though you are writing to a friend. 

So write your sales copy as though you are writing to a friend and telling them 

how great your book is and how it will benefit their life, as though you wrote 

your book specifically for them. 

If you can, identify a problem they might be having and show how your book 

can help them.  You can even use your headlines to help emphasize this: 

• Imagine If… 

• You Can Discover… 
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• Wouldn’t It Be Wonderful If… 

• The Secret To… 

Your main headline is the most important part of your sales copy, so choose 

your words carefully.  And then write the rest of your sales copy and make 

sure that every sentence/paragraph compels them to read on; to want to 

discover more. 

Subheadings can also help to capture the attention of people who prefer to 

scan rather than read. 

Use bullet lists to further break up your sales page, make it visually more 

attractive, easier to read and get the attention of scanners. 

If you’ve already managed to get testimonials for your book, include these too.  

Scatter them liberally throughout your sales page. 

The P.S. 
At the end of your page, include a P.S.  When people scan your page they 

usually only look at headings, sub-headings, lists and the P.S. 

So make sure your P.S.  includes a quick summary of benefits and 

instructions of how to purchase your book. 

A summary in your P.S. also helps to re-enforce the content of your sales 

page in the reader’s mind. 

What is Your USP? 
Every book you write must have a USP (Unique Selling Point).  No matter 

what you write about there is always someone else who has written, or is 

writing, about the same thing.  So you need to know your USP. 

What makes your book better than all the others? 

If you’re not sure what your USP is, write down all the selling points (benefits) 

of your book and then decide which is the best and most important, and how 

this makes your book unique. 

Use a question and answer session to work out all the benefits of your book.  

You can use the list below. 
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Go through the questions one at a time.  Allow your mind to think freely and 

write down everything that comes to you, no matter how overwhelming or 

insignificant it seems, and don’t miss out any details. 

Write down your answers as fully and completely as possible. 

• What are your book’s features? (make a list) 

• How will each one benefit the reader? (can be more than one benefit) 

• What problem/s will your books solve? 

• What benefit is the most important?(your USP) 

• How is your book different? 

• What makes it better than all the other similar books? 

• How can people buy your book quickly? 

 

You also need to understand your reader: 

• Who will buy your book? 

• What motivates them? 

• What are their concerns about your book? 

• Who are you NOT aiming your book at? 

 

By the time you’ve finished answering all the questions about your book and 

your reader, you should have several pages of writing in front of you.  And 

when you read through it you’ll probably find that you’ve written most of your 

sales copy without even realizing it. 

So now you can go ahead and write up your sales page.  Give it a brilliant 

heading, plenty of sub-headings and bullet lists and fill the page with 

compelling writing. 

Finally, add a P.S. to wrap up everything you’ve said - and you’re done. 

Just make sure you have fun writing your sales copy and let your enthusiasm 

for your book shine through. 

And when you’ve finished, it’s time to move on to working on your manuscript. 
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Getting Your Book Ready for Printing 

Before your book can be published and printed you need to do 4 basic things: 

• Get an ISBN 

• Get a barcode 

• Set out the interior of your book correctly 

• Get a book cover 

There are other things that you can do but these are the basic 4 things that 

will get your book ready for publication and distribution.  Everything else will 

be explained as we go along. 

So to begin with you need an ISBN for your book and a barcode for your book 

cover.  The reason that I’m talking about these two together is because your 

barcode will use the same numbers as your ISBN. 

International Standard Book Number (ISBN) 
This is a unique 13-digit number assigned to each book, each edition and 

each binding.  For instance if at first you publish your book as a hard back 

edition, you will need a different ISBN for its paperback equivalent and a 

different ISBN for its ebook edition and a different ISBN for its CD edition, etc.  

This helps to avoid errors in ordering, shipping and receiving books. 

ISBNs aren’t compulsory but they make it simple to identify your work and 

most retail and online bookstores refuse to stock books that don’t have one.  

This is because with the increased use of computers in the book industry, 

ISBNs have become essential. 

The easiest way to obtain an ISBN is through a company called R R Bowker.  

They can be found in the US, the UK and Australia.  You can buy ISBNs 

online at: 

http://www.bowker.com. 

http://www.bowker.co.uk

http://www.thorpe.com.au
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R R Bowker isn’t the only place you can buy ISBNs from, but you need to be 

aware that R R Bowker is the exclusive source of ISBNs.  There are many 

unauthorized resellers of ISBNs and they need to be avoided if at all possible. 

These people buy ISBNs and resell them for a higher price.  So use R R 

Bowker if you live in the US, UK or Australia, or use an official ISBN agency in 

your own country. 

You can find a whole list of International ISBN agencies and an instantly 

downloadable ISBN manual at 

http://www.isbn-international.org/en/agencies.html. 

You used to be able to buy just one ISBN (in most countries), but now you 

have to buy a block of 10.  Once you’ve bought your block of 10 ISBN’s you 

don’t need to assign them to a book straight away.  You can keep them for 

your next 9 books so that your ISBNs are numerical.  But make sure they 

send you all of your numbers otherwise they won’t be numerical.  If they don’t 

send them, ask for them. 

In most countries at least one copy of your book must be given to the national 

library.  This is called a Legal Deposit Copy.  Other copies may be required by 

other state libraries.  ISBN agencies can tell you where to send Legal Deposit 

Copies of your book. 

You can also find more detailed information about ISBNs from: 

• http://www.collectionscanada.ca 

• http://www.whitaker.co.uk 

• http://www.thorpe.com.au/isbn 

 

Global Books in Print 
Once you have your ISBN you should list your book in R R Bowker’s Global 
Books in Print.  You don’t have to have obtained your ISBN from Bowker to 

list your book in Global Books in Print. 

This database is available to book retailers and libraries worldwide.  Your 

book doesn’t have to have been published yet either to list it with Global 
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Books in Print because you can fill in the ABI (Advanced Book Information) 

and then go back later to update this information and add a thumbnail image 

of your book cover. 

To register your title with them go to http://www.bowkerlink.com. 

There is a plethora of information on the internet and in books as to where you 

should list your book to let it be known globally that it is available.  But 

Bowker’s Global Books in Print is by far the most important so if you don’t list 

it anywhere else, make sure you list it here. 

Barcodes 
A barcode should be added to the back cover of a book in the bottom, right 

hand corner.  It should contain the same numbers as your ISBN which should 

be printed above it.  Wholesalers and retails don’t usually accept a book 

without a barcode.  If you’ve already printed your book without a barcode, you 

can purchase barcodes printed on stickers from most printing companies. 

Or you can download your own barcode-creating software.  A free version can 

be found at: 

http://www.freedownloadcenter.com/Business/Printer_Tools/Barcode_Creator.

html. 

You can also download free barcode creating software from 

http://www.download.com.  Just type “barcode” or “free barcode” into the 

search box when you get there. 

Some people will try and tell you that you need to include an EAN (European 

Article Number) on your barcode, but it really isn’t necessary. 

All manufactured retail goods are issued with an EAN (European Article 

Number).  This is a 13-digit number just like an ISBN, so with books you only 

need the ISBN and not an EAN.  In Japan, they use a JAN (Japanese Article 

Number), but again, your ISBN can be used instead of this. 

Some years ago all retail products were given a UPC (Universal Product 

Code) number.  UPC’s were eventually replaced with EAN’s.   
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EAN, ISBN, UPC and JAN are all collectively called Global Trade Item 

Numbers. 

N.B.  A point worth mentioning here is that it would be wise to go online and 

search to see if anyone else has the same book title as the one you want to 

use.  Even with the use of ISBNs and Barcodes, it can still be confusing if two 

books have exactly the same title.  If someone else is using your preferred 

title, perhaps you could change yours by adding a different subtitle. 

Copyright 
For your own protection you should find a copyright agency to register your 

book with before you publish it (or preferably as soon as you finish writing it).  

This will help to protect you if anyone accuses you of plagiarism or any other 

kind of copyright infringement. 

Once your book is registered with a copyright agency (which can be done 

online in only a few minutes) they can also handle any queries from anyone 

who wants to legally copy part of your work and they can also handle fees and 

payments on your behalf. 

Some of the following agencies might be of use: 

• http://www.cla.co.uk 

• http://www.copyright.com.au 

• http://www.copyright.com 

 

Illustrations 
If the interior of your book requires illustrations (or you need a picture for your 

front cover) make sure you have them ready plus all the correct copyright 

permissions to be able to reproduce them. 

Using online picture libraries is the easiest way to get illustrations for your 

book.  You could use individual book illustrators instead, but this can be time 

consuming and expensive.  Picture libraries are quick and easy to use and 

cost much less. 
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If you purchase an illustration or photograph, make sure you obtain copyright 

in perpetuity otherwise you’ll have to pay every time you use the illustration or 

pay royalties. 

Here is a list of picture libraries to get you started: 

• http://www.stockvault.net has over 7,000 free, good quality images.  

They also have lots of other useful information including design 

tutorials.  A good site if you’re just starting out. 

• http://www.istockphoto.com has over 1.8 million images in stock at 

prices ranging from $1 for web publishing images, up to $15 for large 

poster-quality pictures. 

• http://www.dreamtime.com sell images on a credit-based system and 

you have to buy credits in groups of a minimum 20 credits.  1 credit 

buys you an image suitable for web publishing and a large poster-

quality image is 3 credits.  All images are of exceptionally high quality. 

• http://www.fotolia.com has 3.3 million images to choose from, ranging 

from $1 to $3 per image and has a great search facility. 

 

If you have any good photos or images, you might want to consider making 

some money yourself by submitting them to the above websites for other 

people to buy. 

Using Microsoft Word To Make Your Book Printer-Ready 

The pages of your book need to be set out correctly, ready to go to the printer. 

When producing books, many authors and publishing companies use software 

such as Quark Xpress, Adobe InDesign or Adobe PageMaker to produce 

good type. 

But if all this sounds unfamiliar to you, don’t worry because printer-ready 

results can also be achieved using Microsoft Word. 

No doubt you have the final draft of your manuscript set out in an A4 layout, 

which is, of course, too large to print as a book.  That is, of course, unless 
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your finished book is to be A4 size, in which case you’re good to go.  But 

assuming you need a smaller size, we’ll carry on. 

Firstly you’ll need to change your page size and probably your font and 

margins too. 

First, lay out your manuscript on A5 size pages (go to the File menu and click 

on “page setup” and choose your page size) then adjust the margins so that 

your text will fit comfortably on the page of the eventual trimmed size of your 

printed book.  Allow a margin of at least 2cm on the right margin and 2.5 on 

the left margin.  Also adjust your top and bottom margins to 2cm. 

It is also important that you click on “Mirror Margins” in your Page Setup.  

This sets your page layout for left and right pages that “mirror” each other, just 

like in an open book. 

If you’re at all unsure of how your finished page should look, just take a few 

similar books from your own book shelves and see how they are laid out. 

Font Size 
Word’s default font size is 10 point but this is too small to comfortably read in 

paperback.  Most paperbacks are best to read with a minimum of 40 

characters per line and maximum of 70.  40 is the most comfortable small font 

size for most readers, which is 12 point.  Note: there are 72 points to 1 inch. 

Text in printed books is always justified. 

Font Face 
Word’s default font face, or more correctly, typeface, is Times New Roman.  

This typeface is so called because it was designed to be the best typeface for 

the narrow columns of print in the Times Newspaper and so was never 

intended to be used in books. 

Another typeface of greater width would be more suitable.  Try using Palatino 

or Georgia or Arial. 

Just out of interest, the typeface you’re reading now is Arial. 

Line Spacing 
Word’s standard line spacing is “single”, “1.5” or “double”.  A more preferred 

line spacing should be set to an exact point measurement that is 2 to 4 points 
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larger than your font size.  For example, if your font size is 12 point, go into 

the Format menu and choose paragraph.  For line spacing select “at least” or 

“exactly” and then choose 14 to 16 point. 

Characters 
Make sure you use “typographic” characters and not “typewriter” characters.  

For instance, use “smart quotes” instead of "straight quotes" and don’t use 

single hyphens (-) or double hyphens (--) instead of a dash (–) or “em dash” 

as it’s correctly called. 

To use correct characters go to the Insert menu and choose “symbol” to find 

the right typographic character.  Alternatively, go into the Tools menu, choose 

“Auto Correct” and “Auto Format” and “Auto Format as you Type”.  Using this 

option changes characters as you type. 

Remember to also use “justified” for your page layout. 

Styles 
Word has a Style feature that allows you to apply different styles and 

attributes to selected text.  The style will then continue to change 

automatically to all text governed by that style. 

For instance, if you want all your headings to be size 16 font and underlined 

and all your subheadings to be size 12 font and bold, you can set up a style to 

do this for you automatically.  It’s easy to set up, and using styles can save 

you an enormous amount of time while writing your book and it also ensures 

consistency.  You can also store styles in a template to use again in a future 

book. 

You can find Styles under the Format menu 

Automatic Kerning 
Kerning means moving individual letters closer or further apart to make the 

text appear more even. 

Word does have automatic kerning which can be turned on in the Format 

menu and choosing “character spacing”. 

Kerning doesn’t usually improve justified blocks of text, but it works well when 

used on single lines of text such as titles and headings. 
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Page Breaks 
Word can insert page breaks so that even if you go back and add more text 

the page will still end exactly where you inserted the page break.  This is 

important when using chapters. 

Go to the Insert menu and choose “insert break” and then click “page break”.  

Make sure your curser is already positioned where you want the page break. 

You can also use the “line break” option to ensure text always begins on a 

new line.  On the view menu, choose “show all” to see where these breaks 

have been placed.  This will also show character spacing. 

Windows and Orphans 
Always avoid Windows and Orphans. 

An orphan is the first line of a paragraph that appears at the bottom of a page 

by itself or has a heading above it, and continues on the next page. 

A window is the opposite of this and is the last line of a paragraph that 

appears at the top of a page by itself. 

Word usually avoids windows and orphans by default.  But if it doesn’t, go into 

the Format menu, click on “paragraph” and then choose “line and page 

breaks” and turn it on there. 

Following all the suggestions here will produce work that’s about 90% as 

accurate as using the other software packages. 

If you want to learn more about how you can improve your work using Word, 

take a look at  

Perfect Pages: Self-Publishing with Microsoft Word by Aaron Shepard. 

 

This is an Excerpt from Self Publish Worldwide. 

 

Click Here to Buy the Complete ebook.
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